INTERNSHIP TRAINING REPORT

INTER UNIVERSITY CENTRE FOR GEOSPATIAL INFORMATION
SCIENCES AND TECHNOLOGY, UNIVERSITY OF KERALA,
KARYAVATTOM CAMPUS

(RSTY.OF
"

»

N

E/
i
5

)

MEGHA KENNADY
6151100012

Submitted to the University of Kerala in partial fulfilment of
the requirement for the degree of

Master of Science in Environmental Sciences

RESEARCH CENTRE AND POST GRADUATE DEPARTMENT OF
ENVIRONMENTAL SCIENCES

ALL SAINTS' COLLEGE

UNIVERSITY OF KERALA

THIRUVANANTHAPURAM



R R NNAAANSSAAAA U A S A A A A SR A AN

CERTIFICATE

This is to certify that Ms. Megha Kennady, Second year MSc Environmental Sciences
student, All Saints’ College, Trivandrum has done a one month long internship programme
under my guidance at the Inter University Centre for Geospatial Information Science and

Technology (IUCGIST), Kariavattom Campus, University of Kerala during the period from

25™ April 2022 to 25" May 2022.
W
5|4 |2s)

Prof. (Dr.) Rajesh Reghunath

Director, [UCGIST

University of Kerala
DIRECTOR

{UCGIST
University of Kara'n




DECLARATION

| hereby declare that this internship training entitled " GIS Essentials: Mapping and Spatial
Analysis Training" is a record is a record of work carried out by me in partial fulfillment of the
requirement for the degree of Master of Science in Environmental Sciences and that no part of

this work has previously been presented for any other degree or diploma in any university.

September 2022
Thiruvananthapuram Megha Kennady



ACKNOWLEDGEMENT

I bow down before the God almighty for having blessed me with such an opponunity, strength

and confidence for completing the Study.

I extend" my profound gratitude to the Head of the Department of Environmental Sciences, Dr.

Reshma J K, All Saint's College for helping in completing the study.

| deeply indebted to Dr. Rajesh Reghunath, Director, IUCGIST University of Kerala for his
scholarly advice and suggestions, as well as for allowing me to use the lab facilities needed for
this work's geospatial analysis. The help and support provided by Mrs.Vineetha P, a faculty
member of the IUCGIST University of Kerala, is also thankfully acknowledged

I am also thankful to our teachers and our friends who helped me directly or indirectly in the

completion of the internship work.

Last but not the least | am greatly indebted to my parents, other family members, friends, and

well-wishers for their love, encouragement, and moral support.



CONTENTS

SL NO. CONTENTS

2 ORGANIZATION OVERVIEW

4 METHODOLOGY

6 CONCLUSION




INTRODUCTION

Geographic Information System (GIS) captures, stores, analyses, manages and presents data,
which is linked to locations or having spatial distribution. It is a computer — based system with
four sets of tools for managing georeferenced information.
These includes,
Data capture: graphic data (digitized, converted from existing data) and attribute data
(Keyed in, loaded from existing data files)
Data storage and manipulation: file management and editing.
Data analysis: Database query, spatial analysis and modelling.

Data display: maps and reports

GIS is run on all spectrums of computer systems ranging from personal computers to
multi — user supercomputers, and are available in a wide variety of software languages. GIS is
a useful tool for data integration, automated mapping and information analysis. Large volume
of data is directly and conveniently accessible using the powerful GIS software, tools in
problem — oriented systems. They can show and interpret the data in a way that is directly
understandable and helpful for decision — making processes, supporting their interactive
analysis. Different data kinds that are located in the same geographic area can be managed by
a GIS. The main benefit of GIS is that it makes it simple to read, analyse, and determine the
spatial relationships between many layers of spatial data presented as maps and satellite
pictures. The goal of GIS is to supports and make decisions for the management and efficient

conservation of natural resources more confidently.

Remote sensing (RS) technology was created much earlier than geographic information
systems (GIS). RS gathers data about physical objects via measurements taken at a distance,
without actually coming into contact with the object. Three phases of remote sensing
technology can be identified: (i) gathering data from a sensor deployed on a platform, such as
a satellite; and (ii) managing the data: (iii) data interpretation that results in the creation of
thematic maps of the surfaces under investigation. A source, interactions with the earth's
surface, interactions with the atmosphere, and a sensor make up an electromagnetic radiation-
based remote sensing system. The sun’s reflected light and the earth’s heat are examples of
natural sources of electromagnetic radiation, while microwave radar is an artificial one. The

features of the objects affect the earth’s surface interaction, which determines the quantity and



nature of radiation emitted or reflected from the earth’s surface. A sensor, like a radiometer or
camera, records the electromagnetic radiation that has interacted with the atmosphere and the
earth’s surface. Electromagnetic energy travelling through the atmosphere is bent and scattered,

and this phenomenon is referred to as atmospheric interaction.

The earliest kind of remote sensing was aerial photography, which is still the most
popular form of remote sensing even in the era of satellites and electronic scanners. Aerial
photography is the process of taking pictures of the earth's surface using a camera mounted on
an aeroplane or balloon. These images are quite helpful for creating large-scale maps. Radar is
used to gather aerial sensor imageries. Remote sensing by satellite is a modern invention. The
design of remote sensing satellites is based on the intended use, such as the analysis of the

earth's resources, meteorology, communication, or military objectives.

The Landsat series from the United States, the SPOT satellite series from France, and
the IRS series from India are the most frequently used earth resource satellites. These contain
a variety of scanners, including Multispectral Scanner (MSS). Topical Mapper (TM). Scanner
that is panchromatic (PAN). scanner with high resolution visible (HRV). Wide Field Scanner
(WIFS), Linear Imaging and Self Scanning (LISS) technology, etc. The most popular
meteorological satellites are NOAA, NIMBUS, GOES Meteos, and Himawari. The satellite
company or its designated receiving stations are where the user countries can purchase satellite
data in digital or graphical format directly. GIS tools can digitise and analyse remote sensing
data to produce exact outputs in a variety of formats. Land use planning and management,
natural resource management (land, water, agricultural, and fishery), forestry and wildlife
management, soil degradation studies, and enumeration area mapping are the main applications
for GIS and RS. Natural hazard mapping, disaster forecasting and management, environmental
impact studies, mineral exploration, etc. Globally, the use of GIS and RS for resource planning

and management, both of natural and artificial resources, is rising quickly.

Internship is an integral platform for anyone to gain experience in an actual workplace.
An internship was done at Inter University Centre for Geospatial Information Sciences and
Technology, University of Kerala, Karyavattom Campus during the period 22nd April 2022 to
10th June 2022 on Remote Sensing and GIS. GIS is a computer — based tool for mapping and
analysing features and events on earth. It integrates common database operations, such a query
and statistical analysis, with maps. On the other hand, remote sensing is the science of

collecting data regarding an object or a phenomenon without any physical contact with the



object. The data collected through remote sensing is integrated into GIS. It was a good
opportunity for us to improve our general research and GIS research skills, to prepare and use
data for GIS analysis and to present the analysis. The internship was significant and beneficial
because it developed skills that are marketable, required in the workplace, and increased critical

thinking skills.

The theory sections of the internship help us to learn about the concept of GIS and
Remote Sensing. During the later sessions, we learned about the ArcGIS software and their
operational features which allows the storage, handling and analysis of the geographical
information. ERDAS Imagine software was used to learn about the classification of the Land
Use/ Land Cover classes and for the LULC map creations. Several other operations are also
learned related to our researches like georeferencing, LULC map creation, LST calculation,

Vegetation Indices calculation, Shore line fluctuation analysis, Buffer map creation etc.

The internship was a continual process of learning and evaluation. We learned about
GIS program, GIS analysis tools, and how to utilize GIS and Remote Sensing capabilities in
our research were also learned. The internship was a constant progression of learning and

evaluation, that was supported by critical thinking.

ABOUT THE HOST INSTITUTE

The Inter University Centre for Geo-spatial Information Science and Technology
(earlier it is known as Centre for Geo-Information Science and Technology) was established in
2008 as a joint venture of the University of Kerala, the Department of Science and Technology,
Govt. of India and the Kerala State Council for Science, Technology and Environment. This
inter-institutional, inter-disciplinary centre envisages geo-information management and
capacity building in geo-spatial information infrastructure. Hon'ble Chief Minister of Kerala
Sri. V. S. Achuthanandan inaugurated the centre on 17th March 2008. The centre has already
developed a pilot-scale scalable architecture for well-enabled spatial data management and has

launched map services.

The centre has a post-masters PG Diploma programme in Geo-Information Science and

Technology, a full-time two-semester course consisting of specialized training in remote



sensing, photogrammetry and GIS. In addition to this, the centre conducts short term training

programmes and training workshops for the researchers, officials and end-users.




LEARNING OUTCOMES

During the first week, we had a theory section on GIS and remote sensing by Vineetha
P, Lecturer at Inter University Centre for Geospatial Information and Technology. It really
helps us a lot to understand about the concept of GIS and remote sensing. Remote sensing is
one of the methods commonly used for collecting physical data to be integrated into GIS.
Remote sensors collect data from objects on the earth without any direct contact. They do this

by detecting energy reflected from the earth, and are typically mounted on satellites or aircraft.

Then we were introduced to ArcGIS software and its operational features. ArcGIS is a
geographical information system (GIS) software that allows handling and analysing
geographical information by visualizing geographical statistics through layer building maps
like climate data or trade flows. In ArcGIS, we had learnt how to georeference toposheets.
Georeferencing is a process of establishing a mathematical relationship between the image

coordinate system and the real-world spatial coordinate system.

To perform image to image georeferencing first add a topographic map and then right-
click Table of Contents, select a target layer (the referenced dataset), and click Zoom to Layer.
Then on the Georeferencing toolbar, click the Layer drop-down arrow, and select the raster
layer to be georeferenced. Click Georeferencing > Fit to Display. This displays the raster

dataset in the same area as the reference layer.

Click the Control Points tool to add control points. To add a link, click on a known
location on the raster dataset and on a known location on the referenced data. Notice the image
shift with each control point added. Add as many controls as needed until the data are aligned
correctly. Click Georeferencing > Update Georeferencing to save the transformation
information with the raster dataset. This creates a new file with the same name as the raster

dataset, but with an AUX file extension. It also creates a world file for TIFF and IMG files.

Calculation of vegetation indices using raster calculator were also done using ArcGIS.
The Normalized Difference Vegetation Index (NDVI) measures the greenness and the density
of the vegetation captured in a satellite image. Healthy vegetation has a very characteristic
spectral reflectance curve which we can benefit from by calculating the difference between two

bands — visible red and near-infrared.

During the following days, we were also taught about bubble map and how to create it.

Bubble Map is all about symbolizing layers to represent quantity, as it mostly works in the



same way as quantity map. Bubble map uses range of coloured bubbles of different sizes in
visualization of data and is also known as a “graduated marker map”. A bubble map shows
circular markers for points, lines, and polygon features of different size. The bubble sizes are

based on a selected numerical attribute value from user’s uploaded layer.

Towards the last days of our internship, we learned about the creation of a Land
Use/Land Cover (LULC) map. The term Land Use/ Land Cover is used together but each term
has got different meanings. Land cover refers to the surface cover on the ground like vegetation,
urban infrastructure, water, bare soil, etc. Identification of land cover establishes the baseline
information for activities like thematic mapping and change detection analysis. Land use refers
to the purpose the land serves, for example, recreation, wildlife habitat, or agriculture. Land
Use Land Cover (LULC) maps of an area provide information to help users to understand the

current landscape.



1. Georeferencing

In ArcGIS, we had learnt how to georeference toposheets. Georeferencing is a process of

establishing a mathematical relationship between the image coordinate system and the real-

world spatial coordinate system.

a) Image To Image Georeferencing

To perform image to image georeferencing first add a topographic map and then right-
click Table of Contents, select a target layer (the referenced dataset), and click Zoom
to Layer.

Then on the Georeferencing toolbar, click the Layer drop-down arrow, and select the
raster layer to be georeferenced. Click Georeferencing > Fit To Display.

This displays the raster dataset in the same area as the reference layer.

Click the Control Points tool to add control points. To add a link, click on a known
location on the raster dataset and on a known location on the referenced data. Notice
the image shift with each control point added.

Add as many controls as needed until the data are aligned correctly. Click
Georeferencing > Update Georeferencing to save the transformation information with
the raster dataset.

This creates a new file with the same name as the raster dataset, but with an AUX file

extension. It also creates a world file for TIFF and IMG files.

b) Ground To Image Georeferencing

To perform ground to image georeferencing, from the right-side Catalog window, drag
the unrectified image to the map.

Then Click the Add Control Points tool, click anyone cross point of this unreferenced
image to add the source coordinate of the 1st link.

Click the right button of the mouse and select Input X and Y option from the pop-up
window.

Coordinates dialog box appears, enter the longitude(X) and latitude(Y) value. Then
click OK, follow the same technique and add additional three links for the other three

Cross points.



Click the View Link Table(i) to evaluate the transformation. Input any wrong point or
value choose select link(ii), select a point, and then press the delete button on your
keyboard

Select the Georeferencing dropdown menu and click Rectify. Save as window is
appears, change the output location and also change name and file format, and click
save

Select the unreferenced image from the TOC (Table of Content) window and remove
it. Now Save changes to the existing map window is open, click No button. Because
now you don’t need to save this map.

Before adding the rectified image in the catalog window select rectified image, click
the right button to choose Properties.

Scroll down the Raster Dataset Properties window, on the Spatial Reference Section,
click Edit button.
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2. Vegetation Indices Calculation

Calculation of vegetation indices using raster calculator were also done using ArcGIS.
Vegetation indices (Vis) are the quantitative measure of biomass or vegetation vigour that is
usually formed by adding, dividing, or multiplying the values of several spectral bands to get
asingle value that represents the amount or vigour of vegetation. Vegetation indices are a staple
remote sensing product and the normalized difference vegetation index (NDVI) may be the
most widely used vegetation index. To calculate NDVI you simply need appropriate imagery

and a program that allows you to interact with the image data

Steps involved in the calculation of NDVI are the following.

e Open ArcMap and add satellite images band 4 and band 5 for calculating NDVI.

e Open Arc toolbox in ArcMap

e From the Arc toolbox open Raster calculator (Arc toolbox >Spatial Analyst tool > Map
Algebra tool > Raster Calculator tool)

e When the raster calculator has finished running the resulting NDVI layer will be added

to the ArcGIS interface. NDVI will be displayed as a grayscale image.
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3. Bubble Map

Bubble maps provide a means of graphically representing attributes and analyses associated

with specific wells. Bubble maps are represented as layers within the GIS tab, and can be

selectively enabled or disabled like other layers. To create these graphic representations, a

coloured shape is overlaid on the entity. Both the colour and the shape reflect one of the

properties associated with the entity. As the value of the property changes, the colour changes

within a set range. In more complicated cases, multiple properties can be associated with

different settings including variations in colour, size, angle, and shape, according to the scale

you set.

The different steps involved in creating a bubble map the following:

e To add / create a bubble map, start by selecting wells for the bubble map. In the GIS

Configuration pane, click the + icon and select Add Bubble Map Layer.

e Type aname for your bubble map layer and click Next. If you create a bubble map with

the same name, a number is incrementally added to the name.

e Each tab in Preferences enables you to customize a different property that varies with

well properties.

>

Show in Legend — select whether this property is displayed in the legend. If the
property is using a variable colour setting, by default, the property is displayed in
the legend.

Fixed Colour / Size / Angle / Shape — all wells show the same property, as set in
the dialog box.

Variable Colour / Size / Angle / Shape — select an attribute or analysis result on
which to vary the property. When selecting analysis results, an analysis name must
also be selected.

Parameter Type:

Ranged — the colour, size, etc. displayed corresponds to a range of property values

for each parameter.

Set Point — the colour, size, etc. displayed corresponds to a specific value for each

parameter.

Transparency — use the slider to set the level of transparency / opacity for your
bubbles.



» Auto Range — for each ranged property, Harmony Enterprise automatically
detects the appropriate range and division to separate values.

» Reset Ranges — reverts back to a previously saved range, or to the default values.

» Change — when you click this button, the <Colour> Attribute: a property dialog
box opens.

Select the attribute / result from the tree structure.

To edit an existing bubble map, right-click it in the tree structure and select Options. If

you click Variable Colour Settings, the Change button is enabled and you can set the

<colour> for a specific attribute.

To add wells to an existing bubble map, select the well, right-click it and select Bubble

Map, Add to <bubble map name>.
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4. Conversion of Shapefiles to KML in ArcGIS
The major steps involved includes:

e In the Geoprocessing pane of ArcGIS, click Toolboxes, and navigate to Conversion
Tools > KML > Layer To KML

e In the Layer drop-down list, select the shapefile or the layer group containing the
shapefiles.

e Setaname and location for Output File.

e Set other parameters as desired, and click Run.

e The converted KML file is located in the specified output location with a .kmz
extension (compressed or zipped KML files).

e On double clicking the file, it opens in Google Earth App.
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5. Land Surface Temperature

Remote Sensing (RS) and Geographic Information System (GIS) have found wide application
areas in climate change analyses also this can be used for LST calculation. There are various
sensor whose data is useful in generating LST such as advanced very high resolution
radiometer (AVHRR), moderate resolution imaging spectroradiometer (MODIS), Landsat — 8

and many more.

The calculation of Land Surface Temperature using the Landsat 8 thermal bands are done using

Six steps:

e Calculation of Top of Atmospheric spectral radiance

e Top of Atmospheric spectral radiance to Brightness Temperature Conversion
e Calculation of Normalized Difference Vegetation Index

e Calculation of the proportion of vegetation

e Calculation of emissivity

e Calculation of Land Surface Temperature

The estimation of Land Surface Temperature using Landsat 5 thermal bands includes the

following steps:

e Conversion of DN to Radiance
e Conversion of Radiance into Brightness Temperature in Kelvin

e Conversion of Degree Kelvin into Degree Celsius
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CONCLUSION

The internship was a useful experience. We have learned many about Remote sensing
techniques and GIS. We achieved many of our learning goals, such as prepare and use data for
GIS analysis, and to present the analysis. There were many factors that helped as accomplish

these goals.

Our guide Vineetha P, Lecturer at Inter University Centre for Geospatial Information and
Technology, is extremely knowledgeable and passionate about the topic and finding ways to
reduce it and solve our issues and gave us theory section on GIS and remote sensing. She is
also very positive and helpful and is concerned with developing the intern’s ability. To help
researchers and interns, the institute has developed basic search and computer search strategies,
a data collection process, and has established steps to follow in the research process. It really
helps us a lot to understand about the concept of GIS and remote sensing. The time spent with
her was extremely valuable for our project. Besides conducting georeferencing, calculation of
vegetation indices, creating maps, point features, line features and polygon features, we also
needed to know how to use QGIS. Being that the documentation and tutorials for QGIS are
online, our skills were continually tested and improved. Characteristics of digital satellite
image, processing of digital images, image enhancement, filtering and its classification were
discussed. The application of remote sensing and GIS were also discussed. Not only did we
gain practical skills but also had the opportunity of self-learning by reading articles and
journals. The internship also involved taking part in and helped very lot to do our project works.
In either case, discussions occurred between the participants and the tutor enhanced our
learning experience. The experience of being a GIS and Remote sensing Intern was very

beneficial for us.

The experience of being a GIS and remote sensing techniques learning were very beneficial for
us. It improved and honed our skills in many ways. It increased our critical thinking ability.
Therefore, the internship was valuable not only for learning “things,” but also improved our
basic knowledge on the usage of the different GIS applications. Overall, the internship at
IUCGIST has been a success. We were able to gain practical skills, work in a fantastic

environment, and make connections that will last a lifetime.



